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弾性ネットワークモデルによる基準振動解析ソフト弾性ネットワークモデルによる基準振動解析ソフト弾性ネットワークモデルによる基準振動解析ソフト弾性ネットワークモデルによる基準振動解析ソフト PDBETA の使い方の使い方の使い方の使い方 

    

早稲田大学早稲田大学早稲田大学早稲田大学        輪湖輪湖輪湖輪湖    博博博博    

    

I.I.I.I.    弾性ネットワークモデルによる基準振動解析弾性ネットワークモデルによる基準振動解析弾性ネットワークモデルによる基準振動解析弾性ネットワークモデルによる基準振動解析    

１．基準振動解析１．基準振動解析１．基準振動解析１．基準振動解析法法法法    

 エネルギー極小構造のまわりのポテンシャル面を多次元の放物面で近似できるとしたとき、そ

の系の揺らぎは、さまざまな周波数の単振動モードに分解できる。そして現実の揺らぎは、それ

ら振動モードの重ね合わせとして近似できるとして解析する手法。 

 

２．計算方法２．計算方法２．計算方法２．計算方法    

①①①①独立変数独立変数独立変数独立変数：：：：  化学結合のまわりの回転角（二面角）。 

共有結合長、結合角を固定して扱う。そのため、芳香環など環状構造は原則的に剛体として扱

う。例外として、S-S 結合や核酸の糖環の１つの共有結合は非共有結合とみなし（ただし、結

合長、結合角が標準値になるよう制約を課している）、変形できるようにしている。 

②②②②ポテンシャル形ポテンシャル形ポテンシャル形ポテンシャル形：：：：    

弾性ネットワークモデルでは、原子の種類に関係なく、すべて同じ関数形、同じパラメータ値

を用いる。
2

2

2

))(
)(

exp( PDB
ijij

PDB
ij dd
a

d
K −−     dij は原子 i と j の距離（変数）で、dij
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PDBデータの立体構造での距離。バネ定数にあたる係数は距離の増大とともに減衰する。K、a

は適当に決めた定数。PDBETAでは、利用者が、K、a の値を自由に設定できる。 

 

③③③③エネルギー極小化エネルギー極小化エネルギー極小化エネルギー極小化：：：：    

正統な基準振動解析では、PDBの立体構造に対してエネルギー極小化を行うことが必要である

が、弾性ネットワークモデルでは PDBの立体構造が上記ポテンシャル関数の極小値となってい

るので、必要ない。この点が、計算の高速化に大きく寄与している。 

 

３．得られる情報３．得られる情報３．得られる情報３．得られる情報    

時間平均 （EXCEL 等で結果を読み込んでグラフ化する） 

・原子の揺らぎの大きさ。  ・２つの原子の揺らぎの相関。 

・二面角の揺らぎの大きさ。 ・２つの二面角の揺らぎの相関。 

  各モードについて 

・原子の変位ベクトル。   ・２つの原子の変位ベクトルの内積。 
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・二面角の揺らぎ。 

 

立体構造ビューワー jV、Jmolを使って揺らぎを見る。 

・原子の揺らぎのアニメーション 

・原子の変位ベクトル図 

 

【例】1a6m myoglobin 

        

 

         

 

４４４４．基準振動解析データベース．基準振動解析データベース．基準振動解析データベース．基準振動解析データベース ProMode-Elastic    

・データベース ProMode-Elastic 

http://promode.pdbj.org/promode_elastic/ 

・ソフト PDBETA（Windows版のみ）のダウンロード 

上記サイトの中のリンク Download of software へアクセスする。 

二面角 φ, ψ, χ1の揺らぎの大きさ 

原子の揺らぎの大きさ（残基ごとの平均） 

第２低振動数モード

の変位ベクトル 

第１低振動数モードの

変位ベクトルの内積 
変位ベクトルの

内積の時間平均 
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II.II.II.II.    実習実習実習実習    

    

０．準備０．準備０．準備０．準備    

0.1    弾性ネットワークモデルによる基準振動解析ソフト弾性ネットワークモデルによる基準振動解析ソフト弾性ネットワークモデルによる基準振動解析ソフト弾性ネットワークモデルによる基準振動解析ソフト PDBηのダウンロードのダウンロードのダウンロードのダウンロード    

 

ProMode-Elastic のトップページ（http://promode.pdbj.org/promode_elastic/; 日本語ページ

と英語ページがある）で 

① ソフトウェアのダウンロード（あるいは Download of Software） をクリック 

② 受諾します（あるいは I agree to the above conditions）ボタンをクリック 

③ Windows用実行ファイル（Windows executable） Window PDBETA v1.01 をクリックして、

PDBETA-v1.01.zipを適当なフォルダーにダウンロードし、解凍する。 

PDBETA-v1.01というフォルダーができる。 

④ DSSP サイトへのリンク http://swift.cmbi.ru.nl/gv/dssp/ へアクセスし、実行ファイル

（DSSPCMBI.EXE）をダウンロードする（オプション） 

http://swift.cmbi.ru.nl/gv/dssp/ にアクセス 

Miscellaneous ⇒ Distribution ⇒ DSSP old ⇒ Windows executable 

③で出来たフォルダーPDBETA-v1.01/bin に DSSPCMBI.EXEを置く。 

 

0.2    ビューワービューワービューワービューワーjV のダウンロードのダウンロードのダウンロードのダウンロード 

 

PDBjのトップページ（http://www.pdbj.org/index_j.html）左側のメニューから 

 サービス＆ソフトウェア ⇒ jV: Graphic Viewer ⇒ ダウンロード・インストール 

  ⇒ バイナリファイル をクリックして条件承諾確認のページへ。 

 ○Accept をクリックした後、next をクリックして、ダウンロードページへ。 

 jV4.0以上のどれかを適当なフォルダーにダウンロードして、解凍する。 

 

0.3    PDB データのダウンロードデータのダウンロードデータのダウンロードデータのダウンロード    

 

PDBjのトップページ（http://www.pdbj.org/index_j.html）本文内の「検索」の窓に PDBのエント

リーコードを入力する。 

  今回は、DNA を含む、比較的小さい系を例として用いる：  3CRO  と入力して検索ボタ

ンをクリック。表の最初の行、PDB ファイルのダウンロードボタンをクリックして PDB データ

を適当なフォルダーにダウンロードする。 
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１．１．１．１．PDBηのののの操作方法操作方法操作方法操作方法 

1.0    アプリケーションの起動アプリケーションの起動アプリケーションの起動アプリケーションの起動 

 

（１）PDBETA-v1.01にあるPDBETA_W.jar（あるいはPDBETA_W.bat）をダブルクリックしてPDBη

を起動する。  ⇒ Page 1 が表示される。 

 

1.1    Page 1 

（１）PDBデータ（新規計算）、あるいは 

中間ファイル（再計算）のファイル名の入力 

① PDBデータ（新規計算）を入力データとする場合 

1) ○New calculationのラジオボタンを選択する。 

2) ファイル名を入力する。あるいは、 

Browseボタンを押してファイルを選択する。 

② 中間ファイル（再計算）の場合は○The intermediate file 

(.PDBeta) のラジオボタンを選択して、前回の計算で出力

された中間ファイルの名前（識別子.PDBeta）を入力する。 

 

（２）Next ボタンをクリックして次のページへ（①の場合、Page 2a-1へ。②の場合、Page 2b-1

へ進む）。本講習会では、②の場合は省略する。 

 

1.2a-1    Page 2a-１１１１ 

（１）計算に取り入れる鎖の選択 

① 計算に取り入れる鎖やヘテロ分子のチェックボック

スをクリックして選択する。 

デフォルトでは、PDBで ATOM のヘッダーをもつタ

ンパク質、DNA、RNA が選択されている。鎖の途中に

HETATM のヘッダーをもつ残基等が含まれる場合、デ

フォルトでは選択されていないので注意が必要である。 
 

（２）出力ファイルの出力先ディレクトリーの入力 

① ディレクトリー名を入力、あるいは Browse ボタン

を押してディレクトリーを選択する。デフォルトは、

PDBデータのあるディレクトリー。 

 

（３）ファイル名の接頭文字列の入力 

① 出力ファイルに付けるファイル名の接頭文字列を入力する（ファイル名として使用できる任意
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の文字列）。すべての出力ファイル名はこの文字列から始まり、PDBηが定義する識別子が付けら

れる。デフォルトは、PDBデータのファイル名。 

 

（４）Nextボタンをクリックして次のページ（Page 2a-2）へ 

 

*** PDB データを読み込み、分子構造記述データを構築します。しばらくお待ちください。*** 

 

 

1.2a-2    Page 2a-2     

 必要なパラメータを設定します。 

しかし、ここではデフォルト値をそのまま使うことに

し、（３）へ進みます。 

 

（１）考慮するモード数の指定 

① すべてのモードを考慮する場合（デフォルト）、 

○All modesのラジオボタンをクリックする。 

（ ）内にモードの総数が表示される。 

② 指定した数の最低振動モードだけで時間平均を求め

る場合（計算時間の短縮となる）。 

○The lowest      modes のラジオボタンをクリックし、考慮するモード数をボックスに入力す

る。モード数のデフォルト値は、100。 

 

（２）ポテンシャル関数に関わるパラメータ値の入力 

 本計算では以下のポテンシャル関数が使われている。 

2
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① K、a、カットオフ距離の値を入力する。カットオフ距離を指定すると、dij
PDB の値がその値よ

り大きい原子ペア i, j に対してはポテンシャルを計算しない。 

デフォルトは、K = 1.0、a = 5.0 Ǻ、カットオフ距離 = 100.0 Ǻ。 

② S-S結合に対する K を設定する。ただし、ポテンシャル関数は
2)( PDB

ijij ddK − 。 

   K の値を入力する。デフォルトは、K = 100.0 

 

（３）Nextボタンをクリックして次のページ（Page 3）へ 

  



Wako - 6 -

1.3    Page 3 

 デフォルトを使うこととし、（４）に進む。 

 

（１）各出力ファイルの冒頭に出力する表題の入力 

① 表題を入力。任意の文字列。 

 

（２）温度を設定する 

といっても、弾性ネットワークモデルでは温度が設

定できないので、基準振動の振幅を設定する。次の①

あるいは②のどちらか一方のラジオボタンをクリック

して選択する。デフォルトは②。 

 

① PDBデータの温度因子から得られる全原子の揺らぎの平均と、基準振動解析計算で得られた全

原子の揺らぎの平均が一致するように温度（振幅）を設定する。両者を比較するには都合がよ

いが、一般に非常に大きな振幅となる。 

② 基準振動解析計算で得られた全原子の揺らぎの平均値を指定する。ただし、0.0 が入力された

場合、①と同じとなる。ラジオボタンをクリックし、平均値を入力する。デフォルトは 0.5 Å。 

 

（３）計算する物理量に関するオプション (1)  

① 原子揺らぎの時間平均。  □ Fluctuation of atoms 

  原子揺らぎの時間平均を計算したい場合、チェックボックスをクリックする。 

② 原子揺らぎの相関の時間平均。 □ Correlation between fluctuations of atoms 

  原子揺らぎの相関の時間平均を計算したい場合、チェックボックスをクリックする。 

   このとき、相関を計算したい原子の種類を指定する（すべての原子ペアを考慮すると、膨

大な数となるため）。次の 3つの中から一つを、ラジオボタンをクリックして選択する。デ

フォルトは CA。 

CA    Cα 原子 

Side chain atom   側鎖の代表原子 

CA and side chain atom  Cα 原子および側鎖の代表原子 

 

（４）Nextボタンをクリックして次のページ（Page 4）へ 
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1.4    Page 4 

 デフォルトを使うこととし、（２）に進む。 

 

（１）計算する物理量に関するオプション (2) 

① 二面角揺らぎの時間平均。 

 二面角揺らぎの時間平均を計算したい場合、 

□Fluctuation of dihedral anglesのチェックボックスをク

リックする。 

②二面角揺らぎの相関の時間平均。 

 二面角揺らぎの相関の時間平均を計算したい場合、 

□Correlation between fluctuations of dihedral anglesのチェ

ックボックスをクリックする。 

 このとき、相関を計算したい二面角の種類を指定する（すべての二面角ペアを考慮すると、膨

大な数となるため）。次の 4つの中から一つを、ラジオボタンをクリックして選択する。デフォル

トは Psi。 

Psi    主鎖二面角ψ 

Side chain dihedral angle  側鎖の代表二面角 

Psi and Phi   主鎖二面角ψとφ 

Psi and side chain dihedral angle  主鎖二面角ψおよび側鎖の代表二面角 

 

（２）Nextボタンをクリックして次のページ（Page 5）へ 

 

1.5    Page 5 

 デフォルトを使うこととし、（２）に進む。 

 

（１）計算する物理量に関するオプション (3) 

個々の基準振動モードに対する計算に関するオプシ

オン。 

① 物理量を計算するモード番号の指定。 

 物理量を計算するモード番号を入力する。参考とし

て、モード総数が表示される。 

あまり大きな値を入れると、計算時間がかかるだけ

でなく、膨大な量のデータが出力されるので注意が必

要である。デフォルトは、1–5。 
 

（２）Nextボタンをクリックして次のページ（Page 6）へ 
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1.6    Page 6 

デフォルトを使うこととし、（２）に進む。 

 

（１）計算する物理量に関するオプション (4) 

計算したい物理量をクリックして選択する。 

① 原子の揺らぎ  □Fluctuation of atoms 

② 二面角の揺らぎ □Fluctuation of dihedral angles 

それぞれ、ボックス内に出力ファイル名が表示される。 
 

（２）Nextボタンをクリックして次のページ（Page 7）

へ 

 

 

1.7    Page 7 

デフォルトを使うこととし、（２）に進む。 

 

（１）アニメーションに関するオプション 

① アニメーションに関するパラメータの入力。 

1) アニメーションのフレーム数を入力する。 

デフォルトは、11。 

2) アニメーションにおける振動の振幅を指定する。 

揺らぎの平均値(デフォルトで、0.5Å)、あるいは 

計算値に対する倍率で指定する。 

Page 3で指定した振幅では、アニメーションにした

場合、動きが小さくてよくわからないことがある。そこ

で、動きを少し誇張してわかりやすくしたい場合、振幅を大きく設定する。 
 

② アニメーションを表示するソフトの選択 

1) jV(PDBj) あるいは Jmolの場合は、□Animation data for jV(PDBj) and Jmolを選択。 

2) Chimeの場合は、□Animation data for Chime(MDL)を選択。 

それぞれ、ボックス内に出力ファイル名が表示される。 
 

（２）Nextボタンをクリックして次のページ（Page 8）へ 
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1.8    Page 8 

デフォルトを使うこととし、（２）に進む。 

 

（１）jV(PDBj)あるいは Jmolで表示する変位ベクトル

に関するオプション 

① 変位ベクトルの倍率 

 変位ベクトルの平均値(デフォルトで、2.5Å)、ある

いは計算値に対する倍率で指定する。 

Page 3で指定した振幅では、長さが短くてよくわか

らないことがある。そこで、少し誇張してわかりやすい

長さに設定する。 
 

 なお、負の値を入力すると、変位ベクトルは逆向きとなる。 

② 描画する変位ベクトルの線の太さを入力する。デフォルトは、2.0。 

③ 描画する変位ベクトルの線の色を RGBの値で指定する。 

ベクトルの根元部分と先端部分で色を変えることができる。（変位ベクトルは、矢印ではなく、

単に線分で表示しているので、その向きを色で区別している）。デフォルトは、根元部分 R = 0、

G = 128、B = 0、 先端部分 R = 255、G = 0、B = 0 

④ jV(PDBj)で表示する変位ベクトル用のデータを出力したい場合、□Displacement vector data for 

the jV viewerのチェックボックスを、Jmol用のデータを出力したい場合、□Displacement vector data 

for the Jmol viewerのチェックボックスをクリックして選択する。 

 

（２）Nextボタンをクリックして次のページ（Page 9）へ 

 

1.9    Page 9 

（１）計算の実行。 

 Executeボタンをクリックする。 

        表示が更新され、計算の途中経過がボックスに表示

される。計算が終了すると、次のページ（Page 10）へ

と進む。 

  エラーが発生した場合は、その旨表示される。 

 

計算実行中計算実行中計算実行中計算実行中!!!!!!!!    しばらくお待ちください。しばらくお待ちください。しばらくお待ちください。しばらくお待ちください。    
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1.10    Page 10 

（１）アプリケーションの終了。 

  Finishボタンをクリックし、ジョブを終了する。 

 

 

 

 

 

 

 

 

 

 

２．２．２．２．出力ファイル出力ファイル出力ファイル出力ファイル     ファイル内部の書式等、詳細はPDBηのHelpをご覧ください。 

 

以下のxxxxはPDBηでユーザーが指定した接頭文字列を表します。 

⇒ EXCELとあるのは、EXCELなどで読み込み、グラフとして表示してください。 

 

xxxx.flcatmA  原子のゆらぎ    ⇒ EXCEL 

xxxx.crratmA  原子のゆらぎの相関   ⇒ EXCEL 

xxxx.flcangA  二面角のゆらぎ   ⇒ EXCEL 

xxxx.crrangA  二面角のゆらぎの相関   ⇒ EXCEL 

xxxx_n.flcatmE  第n番目のモードに対する原子のゆらぎ   ⇒ EXCEL 

xxxx_n.flcangE  第n番目のモードに対する二面角のゆらぎ  ⇒ EXCEL 

xxxx_n-anm.pdb 第n番目のモードに対するjVおよびJmol用のアニメーション・データ  

xxxx_n-anm.xyz 第n番目のモードに対するChime用のアニメーション・データ  

xxxx_n-vec.xml  第n番目のモードに対する変位ベクトル図用データ（jV用）  

xxxx_n-vec.Jmol-script  第n番目のモードに対する変位ベクトル図用データ (Jmol用）  

 

以下は計算に関する情報データで、通常は関係ない 

xxxx-min.pdb  計算した鎖、分子だけを含むPDBデータ  

xxxx.log  基準振動計算のログ  

xxxx_mol.log  PDBデータから分子構造記述データを作成したときのログ  

xxxx-note.txt  設定したパラメータ、オプションなどの記録  

xxxx.pdbeta  再計算用の中間ファイル（バイナリーファイル）  

xxxx.mol  PDBデータから作成した分子構造記述データ  

xxxx.dssp  DSSP（二次構造の同定）の出力結果（DSSPを組み込んでいる場合のみ） 
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３．結果の３．結果の３．結果の３．結果のjVでの表示での表示での表示での表示    

 

ダウンロードした jV を起動する（jv4_0_signed.jar をダブルクリック）。 
 

3.1    アニメーションアニメーションアニメーションアニメーション 

モード番号 n の基準振動の jV 用のアニメーション・データ xxxx_n-anm.pdbを使う。jmol でも

使うことができる。xxxx_n-anm.pdbには PDBデータと同じ様式で、アニメーションのフレーム数

nf に相当するだけの立体構造データがそれぞれ、MODEL 行と ENDMDL 行に挟まれて出力されて

いる。 

 

① xxxx_n-anm.pdbファイルを読み込む。  ② アニメーションをスタートさせる。 

   [File] → [Open-Local] → [Animation]     [Options] → [Animation] 

              

 

③ アニメーションの操作パネルが現れるので、 

□swingにチェックを入れ、再生ボタン▷をクリックす

る。 

swingにチェックを入れることで、データ内の立体構

造が 1, 2, …, nf-1, nf, nf-1, …, 2, 1の順に表示され、

これが繰り返される。ここで nf は、データ内に含ま

れる立体構造の総数である。 
 

3.2 変位ベクトルを描画する変位ベクトルを描画する変位ベクトルを描画する変位ベクトルを描画する 

① jV を起動し、対応する PDBデータを読み込む。 

   [File] → [Open-Local] → [PDB] 

 

② 変位ベクトル描画用ファイルxxxx_n-vec.xmlを読

み込む。 

   [File] → [Open-Local] → [Polygon] 
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②の操作を繰り返して、複数のモードの変位ベクトル描画用ファイルを読み込むことができる。

複数のモードの変位ベクトルを読み込んだ場合、モードごとに表示・非表示を後から指定でき

る。 

    

（注意）PDBデータの構造と変位ベクトルとは同じ座標系になくてはならない。①、②の操作

中、画面に表示された構造や変位ベクトルに対して、回転、並進、拡大・縮小といった操作を

すると、両者の構造間にずれが生じる。ちょっとしたマウス操作で、思いもかけずこうした操

作を行ってしまうことがあるので注意する必要がある。 

 

     

 

jV の使い方の使い方の使い方の使い方    

 

マウスの基本操作 

  X 軸（左右方向軸）、Y 軸（上下方向軸）回転  左ドラッグ 
  Z軸（奥行き方向軸）回転    Shift ＋ 右ドラッグ（左右方向） 
  X軸（左右）方向、Y軸（上下）方向に移動  右ドラッグ 
  Z軸（奥行き）方向に移動（拡大・縮小）  Shift ＋ 左ドラッグ 
 
メニュー操作 
 

File  Display  Colors  Options  Help 
 
コマンド操作 
  selectコマンドで一群の原子を選択し、選択した原子群に操作を加える、のが基本操作。 
 
select 原子表現 

 

原子表現： 基本表現は  [残基 ID][:鎖 ID][.原子名]  あるいは  グループ名 

論理値演算子である'and'、'or'、'not'、そして括弧を使った表現ができる。 

 

例：  select 10-20,25-35   残基番号 10-20、25-35の原子 

 select *:A and mainchain   A鎖の主鎖原子すべて 

 select *.CA and not PRO  PROを除くすべてのアミノ酸残基の Cα 原子 

 select (helix,sheet) and hydrophobic  α-helixあるいはβ-sheetに含まれる疎水性残基の原子 

 

グループ名には、アミノ酸名（ALA , GLY など）、アミノ酸の属性（hydrophobic, polar, small
など）、二次構造（helix, sheet, turnなど）、分子の種類（protein, DNA, RNA, water, heteroなど）

がある。また、PDBデータ内の原子の通し番号、MODEL-ENDMDL に対するモデル番号など

を使って、atomno=342とか、model=2 というような指定もすることができる。 

 

select を宣言した後、さまざまな操作を指示する。 

メニューの Displayで分子の表示方法を指定する。コマンドでの指定もできる。 

メニューの Colorsで色を指定する。あるいは color コマンドで色を指定する。 

  colorコマンドの例： color green あるいは color [10,225,100]  （RGBでの指定） 

 

 displayatom on/off   選択した原子群の表示/非表示 も便利なコマンドである。 

 

詳しくは、PDBjのマニュアル http://www.pdbj.org/jv/manual/index_ja.htmlを参照。 


